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ABSTRACT 

In the present study, canal depth, velocity and weather monitoring sensors are designed and 

implemented in the field irrigation laboratory, Aditya Engineering College, Surampalem, Andhra 

Pradesh, India. The depth sensor which is used in this project is HC-SR04 Sensor and the 

velocity sensor is YF-S403. A method of data acquisition and transmission based on 

ThingSpeak IOT is proposed. To record weather data (i.e., temperature, humidity, rainfall depth 

and wind speed) DHT11 Sensor, ultrasonic sensor and IR sensors are used. The purpose of 

this project is to evaluate the performance of real time canal and weather Monitoring devices. A 

structure of real time weather Monitoring devices based on sensors and ThingSpeak IOT, a 

design was developed to realize the independent operation of sensors and wireless data 

transmission can help in minimizing the error in data collection. Arduino UNO is connected with 

canal depth and velocity sensor to generate the output, similarly NodeMCU is connected with 

weather Monitoring Device. The results revealed that observed sensor data showed good 

results when compared/calibrated with the existing conventional measurement system. In order 

to decrease the time and to get accurate value, it is recommended to consider the sensors for 

the proper use and to access weather data easily. The developed device worked satisfactorily 

with minimum or no errors. 

Keywords: Arduino UNO; NodeMCU; DHT11 Sensor; Ultrasonic sensor; IR sensor; 

ThingSpeak IOT; Real Time Weather Monitoring Device; Canal Depth and 

Velocity. 

INTRODUCTION 

Water resource challenges faced by India are considerable and can only be addressed by 

adopting an integrated approach that considers all uses and sources of water (surface water, 

groundwater, etc.) from the river basin/hydrologic perspective [13]. This requires sound 



 

 

information and knowledge on the water resource base and its uses, coupled with the 

availability of appropriate tools for analysis and decision making. Real time knowledge of water 

resources helps planners to make informed decisions for flood forecasting, water supply 

management, irrigation, hydro generation, as well as environmental monitoring and planning. 

The Government of India is cognizant of the need to forge an integrated approach to 

developing, managing, and regulating surface water and groundwater resources, both at the 

basin and aquifer scales.  

Canal irrigation is widely used source of water for irrigation. So, management of 

irrigation canal water is crucial factor in overall irrigation development. The conventional method 

is used to deliver water as per demand by the water users/farmers in form of rotations. The 

conventional system involves lot of weaknesses, including forecast and actual flow or discharge. 

Errors may introduce in flow measurements and water content in reservoirs, also imbalances 

due to human and natural intervention are not considered in the conventional system. Due to 

this, users/farmers at the tail end endure more or shortage water [11].  

Climate change is significantly transforming the water cycle [12]. These cumulative 

impacts on water resources make water availability harder to predict and manage. The 

collective information about the temporal dynamics of weather changes in any industry during 

certain hazards will be helpful in monitoring weather forecasting. Water is the primary medium 

through which we will feel one can realize the effects of climate change.  

A water crisis can mean being flooded by too much water, or having enough water 

without the minimum quality needed to use it. A water crisis may also be the lack of water 

management [13]. The Food and Agriculture Organization of the United Nations indicates that 

for the year 2030 agricultural production will have to be increased by +80% to fulfill food 

demand, but it will have to be done without the possibility of increasing water withdrawals by 

more than +12%, which can be done by reducing spillages along canals [1].  

The potential sophistication of on-farm water management is highly dependent upon the 

level of water delivery service provided to individual farms, which in turn, depends upon the 

conveyance manageability within the complete water distribution system [2]. Modern growth in 

electronics systems, communication system, and information technology assist in designing 

canal monitoring system to provide efficient delivery and avert imbalance.  

In view of above reasons, it is to be made an attempt by introducing the project 

“DESIGN, DEVELOPMENT AND IMPLEMENTATION OF REAL TIME CANAL AND WEATHER 

MONITORING DEVICES” “Design, Development and Implementation of Real Time Canal and 

Weather Monitoring Devices” in which the irrigation will take place only when there will be 



 

 

intense requirement of water from open channels to the field and Real-Time Data for weather 

with the following objectives:  

OBJECTIVES  

1. To Design Sensor based Canal Depth and Velocity Measuring Device.  

2. To Design Real Time Weather Monitoring Device.  

3. To Evaluate the Performance of Real Time Canal and Weather Monitoring Device.  

Chen [3] studied about the network structure of automatic weather station based on 

Internet of things technology was constructed to realize the independent operation of intelligent 

sensors and wireless data transmission. Natividad and Mendez [4] focused only on the water 

level detection and early warning system (via website and/or SMS) that alerts concern agencies 

and individuals for a potential flood event. Vrushali and Patkar [5] discussed on technical levels 

and control aspects of Automatic and grid Meteorological information system. The system 

provided timely and comprehensive meteorological information which was often related to the 

operation of grid to know monitoring, tracing, forecasting and warning of disastrous weather and 

also offers aid decision for load forecasting.  

Kiran and Priti [6] proposed a microcontroller-based design for flow control system for 

gate in canal automation which reduces the water wastage and labour dependency. Omoze et 

al. [7] developed low-cost server-based automatic weather station for remote locations. 

Susmitha and Sowmyabala [8] developed an embedded system to design a weather monitoring 

system which enabled the monitoring of weather parameters in an industry. Amin et al. [9] 

proposed a river monitoring system based on a heterogeneous wireless sensor network to 

address the flow characteristics of river. Wahidah et al. [10] proposed a system that was not 

only able to detect the water level but also able to measure the rise speed of water level and 

alerted the resident. 

This outcome of the review findings is utilized in framing up the methodology to be 

adopted in the present study, which is proposed to design, develop and implementation of the 

real time canal and weather monitoring system. 

2. MATERIAL AND METHODS  

2.1 Design of Sensor Based Canal Depth and Water flow Velocity Measuring Device 

Developing a Device which Measures and Displays the Canal Depth using Ultrasonic 

Sensor (HC-SR04) and the water flow of the canal using water flow sensor (YF-S403) by 

interfacing these sensors and to Arduino UNO board and displaying the result on LCD I2C 

Display. 



 

 

2.1.1 Ultrasonic Sensor HC-SR04  
 

HC-SR04 is an Ultrasonic sensor which measures distance. It emits an ultrasound at 

40000 Hz (40 kHz) which travels through the air and if there is an object or obstacle on its path, 

it will bounce back to the module. Considering the travel time and the speed of the sound, you 

can calculate the distance. The configuration pin of HC-SR04 is VCC (1), TRIG (2), ECHO (3), 

and GND (4). The supply voltage of VCC is +5V and you can attach TRIG and ECHO pin to any 

Digital I/O in your Arduino Board. The module includes Ultrasonic Transmitter, Receiver and 

Control Circuit. The specifications of Canal Depth Sensor were presented in table 1. 

 

Fig. 1 Ultrasonic Sensor HC-SR04 

Table 1 Specifications of Canal Depth Sensor 

Parameter Working range 

Voltage DC 5 V 

Current 15mA 

Frequency  40Hz 

Max Range 4m 

Min Range 2cm 

Measuring Angle 15° 

Trigger Input Signal 10uS TTL pulse 

Echo Output Signal Input TTL lever signal and the range in proportion 

Dimension 45×20×15mm 

 



 

 

2.1.2 Arduino Uno 

The Arduino Uno is a microcontroller board, embedded with the Atmega 328 Processor. 

It has 14 digital input/output pins (of which 6 can be used as PWM outputs), 6 Analog inputs, a 

16 MHz ceramic resonator, a USB connection, a power jack, an ICSP header, and a reset 

button. It contains everything needed to support the microcontroller; simply connect it to a 

computer with a USB cable or power it with an AC-to-DC adapter or battery to get started. The 

Arduino Uno Board can be programmed with the Arduino IDE Software. 

Fig. 2 Arduino UNO R3 Board 

2.1.3 Canal Velocity (Water flow) Measuring Device 

Measuring Velocity of water flow in Canal using Water flow Sensor YF-S403 3/4" by 

Interfacing with Arduino Board and displaying the result on LCD I2C Display. 

Water flow sensor mainly consists of Plastic valve body, rotor assembly and Hall Effect 

Sensor, which is installed between two pipes joining each other for detecting water flow. When 

water flow through the rotor assembly, magnetic rotor will rotate and speed will change as the 

flow change. Hall current sensor output corresponding pulse signal and feedback to controller, 

then the controller will indicate the waterflow reading on the LCD display which is connected. It 

can be used for water heaters, water vending machine, DIY coffee machines, flow 

measurement devices. 

The main components are the Hall Effect sensor, turbine wheel, and magnet. The water 

flows in through the inlet and out through the outlet. The water current drove the wheel to turn, 

and the magnet on the wheel turned with it. Magnetic field rotation triggers the Hall sensor, 

which outputs high- and low-level square waves (pulse). For every round of the wheel, the 

volume of water flowing through is a certain amount, as is the number of square waves output. 

Therefore, we one can calculate the flow of water by counting the number of square waves 

(pulse). 



 

 

 

Fig. 3 Water flow sensor YF-S403 3/4" 

 

Fig. 4 Internal components of water flow sensor 

Table 2 Specifications of Velocity Measuring Sensor 

Parameter Working range 

The lowest rated working voltage DC 4.5 5V - 24V 

Maximum Operating Current 15 mA (DC 5V) 

Working voltage range DC 5 - 18V 

Load capacity ≤ 10 mA (DC 5V) 

Working temperature ≤ 80°C 

Working humidity range 35%-90% RH (no frost) 

Allow Pressure 1.75MPa 

Storage temperature -25 to + 80 ° c 

Save Humidity 25% - 95% RH 

Insulation resistance > 100MΩ 

Flow range 1-30L/min 



 

 

pulse characteristics (4.5 * Q) Q = L / Min ± 3% 

External thread 3/4 " 

 

2.2 Design of Real-Time Weather Monitoring Device 

Interfacing DHT11 Sensor, IR Sensor (Active Type) and Ultrasonic Sensor (HC-SR04) with 

NodeMCU are used for Measuring Temperature, Humidity, Wind Speed and Rainfall Depth and 

Obtaining REAL-TIME data on THINGSPEAK website. 

 

Fig. 5 NodeMCU ESP8266 board 

2.2.1 DHT11 Sensor 

DHT11 digital temperature and humidity sensor is a calibrated digital signal output of the 

temperature and humidity combined sensor. It uses dedicated digital modules capture 

technology and the temperature and humidity sensor technology to ensure that products with 

high reliability and excellent long-term stability. Sensor includes a resistive element and a sense 

of wet NTC temperature measurement devices, and with a high performance 8-bit 

microcontroller connected. The specifications of humidity, temperature and electrical 

characteristics were presented in following tables 3 and 4. 

 

Fig. 6 DHT11 sensor 



 

 

Table 3 Specifications of humidity sensor 

Parameter Specification 

Resolution 16Bit 

Repeatability ±1%RH 

Accuracy 25°c   ±5%RH 

Inter changeability Fully interchangeable 

Response time (a) 1/e(63%)25℃ 6s 
(b) 1m/sAir6s 

Hysteresis <±0.3%RH 

Long-term stability <±0.5%RH/yr 

 

Table 4 Specifications of temperature sensor 

Parameter Specification 

Resolution 16Bit 

Repeatability ±1°c 

Accuracy 25⁰c  ±2°c 

Response time 1/e (63%)  10s 

 

Table 5 Electrical characteristics of DHT11 Sensor 

Component Specification 

Power supply  DC 3.3 ~ 5.5V 

Supply current Measure 0.3mA Standby 60μA 

Sampling period Secondary Greater than 2 seconds 

 

2.2.2 IR Sensor 

An infrared sensor is an electronic instrument that is used to sense certain characteristics of its 

surroundings by either emitting and/or detecting infrared radiation. Infrared sensors are also 

capable of measuring the heat being emitted by an object and detecting motion. An IR sensor 

consists of an IR LED and an IR Photodiode; together they are called Photo–Coupler or Opto–

Coupler. Infrared Obstacle Sensor has a built-in IR transmitter and IR receiver. Even though an 

IR LED looks like a normal LED, the radiation emitted by it is invisible to the human eye. When 



 

 

the IR transmitter emits radiation, it reaches the object and some of the radiation reflects back to 

the IR receiver. 

In this project, we have designing Digital Tachometer using an IR Sensor with NodeMCU 

for measuring the number of rotations of Anemometer in KMPH. The Tachometer is an RPM 

counter which counts the number of rotations per minute. We are designing a NodeMCU-based 

digital tachometer using an IR sensor module to detect objects for count rotation of any rotating 

body. IR transmits IR rays which reflect back to the IR receiver and then IR Module generates 

an output or pulse which is detected by the NodeMCU controller. 

 

Fig. 7 IR sensor (Infrared obstacle) 

2.2.3 Rainfall Depth Measuring Device 

Interfacing Ultrasonic Sensor (HC-SR04) with NodeMCU for Measuring Rainfall Depth in a Pan 

Evaporimeter 

2.2.3.1 Ultrasonic Sensor (HC-SR04) 

HC-SR04 is an Ultrasonic sensor which measure distance. In this project, we will have to 

mention the Height (Depth) of the Pan Evaporimeter in the Programming Code. When there is a 

Rainfall, the Ultrasonic Sensor detects the change in the Depth of the Pan Evaporimeter and 

displays the depth of Rainfall. 

2.3 Performance Evaluation of Canal Depth Measuring Device  

The Sensor Based Canal Depth Measuring Device is used to measure the Depth of the Canal in 

Non-Contact Method. The obtained Result which will be Compared with the Traditional Method 

of Measuring Canal Depth using Staff Guage. These results shows that the accuracy of the 

sensor. 



 

 

 

Fig. 8 Sensor based canal depth measuring device 

 

Fig. 9. Measuring canal depth with staff gauge 

2.4 Performance Evaluation of Real Time Weather Monitoring Device  

The Weather Monitoring Device will be installed in the field and the Results of the Respective 

Sensor will be Observed and Evaluated with the Data available in the AP Govt. Website 

(http://www.apsdps.ap.gov.in/).  The Data from the Sensors in THIINGSPEAK IOT Server 

and the Available Data from the, Andhra Pradesh AP Government website will be 

Compared and Plotted on a graph for analyzing the Accuracy of the Sensor Measuring 

Data 

 



 

 

 

Fig. 10 Real time weather monitoring device 

3. RESULTS AND DISCUSSIONS 

3.1 DESIGN OF SENSOR BASED CANAL DEPTH AND WATERFLOW VELOCITY 
MEASURING DEVICE 

3.1.1 Canal Depth Measuring Device 

Interfacing Ultrasonic Sensor (HC-SR04) and LCD I2C Display with the Arduino UNO Board and 

Uploading the Program for Measuring the Canal Depth. By Transmitting and Receiving signals 

returned to the Ultrasonic Sensor, the depth will be measured. 

Steps: 

1. Initially, do the wiring by following the Circuit Diagram and connect the Arduino Board to 

the PC/Laptop. 

2. Open Arduino IDE Software in PC/Laptop and copy the code into the new file and save. 

3. Select the Arduino board, by selecting Tools > Board > Arduino UNO 

4. Select the COM Port, Tools > Port > COM... 

5. Upload the code by pressing Ctrl + U or Sketch > Upload 

6. After uploading successfully, make sure that the baudrate speed is 9600 on the Serial 

Monitor. 

7. Results will be displayed on the LCD Display. 

 

 

3.1.2 Canal Velocity (Water flow) Measuring Device  



 

 

Interfacing the water flow sensor YF-S403 3/4" with Arduino and LCD I2C Display, and 

uploading the program for displaying Velocity of water. The water flow sensor consisting a Hall 

Effect Sensor inside will sense the flow rate of the liquid. 

 

Fig. 11 Interfacing YF-S403 sensor and LCD I2C display to Arduino Board 

3.2 DESIGN OF REAL-TIME WEATHER MONITORING DEVICE  

3.2.1 Temperature and Humidity Measuring Device 

Interfacing DHT11 Sensor, IR Sensor (Active Type) and Ultrasonic Sensor (HC-SR04) with 

NodeMCU for Measuring Temperature, Humidity, Wind Speed and Rainfall Depth and obtaining 

REAL - TIME Data on THINGSPEAK website. 

 



 

 

Fig. 12 Interfacing DHT11 sensor to NodeMCU 

 

Fig. 13 DHT11 sensor output 

3.2.2 Wind Speed Measuring Device  

Interfacing IR Sensor with the NodeMCU Board for Measuring wind Speed with Anemometer 

and Displaying the readings on the Serial Monitor. 

 

Fig. 14 Interfacing IR sensor to NodeMCU 



 

 

                         

Fig. 15 IR sensor positioned with Anemometer  Fig. 16 IR sensor output 

3.2.3 Rainfall Depth Measuring Device 

Interfacing Ultrasonic Sensor (HC-SR04) with the NodeMCU Board for Measuring Rainfall 

Depth and Displaying the values on the Serial Monitor. 

                 

    Fig. 17 HC-SR04 sensor measuring rainfall depth     Fig. 18 Ultrasonic sensor output 

3.3 Performance Evaluation of Canal Depth and Weather Monitoring Device 

The R2 values for different sensor-based parameters when compared with traditional method 

are presented in following table 6. 



 

 

Table 6. R2 values between observed and measured data 

Parameter R2 

Temperature 96 

Humidity 92 

Wind speed 89 

Rainfall depth 97 

The Cost of making Sensor based Canal Depth Measuring Device was approximately 

Rs.1530 and the cost of making Weather Monitoring Device was approximately Rs.660. In 

present market, the cost of Weather Station which are available in the India ranges from Min 

Rs.5000 to Max of 25000. 

4. CONCLUSION 

Technological change, particularly in developing countries, is not only about innovating 

at the frontier, but also about adapting existing products and processes to achieve higher levels 

of productivity as applicable to their local contexts. a great opportunity for developing countries 

to set-up monitoring systems with accessible technology at a low-cost, which could be used in 

future to address a number of practical issues including, but not limited to, flood-water and 

urban drainage management, climate change impact assessment, early warning and risk 

management, as well as now-casting and weather predictions. 

The requirement of the release of water into a main canal can be predicted on a 

scientific basis and this will allow for a more flexible operation of the canal system. The linkage 

of real-time data collection and monitoring of climate crop-soil relation parameters with the canal 

automation of the conveyance and distribution system will be achieved. In view of the presented 

results, the proposed solution can be considered a valuable alternative to conventional weather 

systems in helping fill the gap in the monitoring system for low-income economy and developing 

countries. The evaluated parameters showed very promising results, with the existing 

conventional measurement system. 

With this research we have proven that it is possible to implement a fully open weather 

monitoring solution based on open hardware, open software, open standard and open data, one 

that is capable of providing high quality data. Further activities will have to test this solution in a 

real case experiment, in order to evaluate the system’s sustainability and durability in real 

conditions. 
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